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Preface 

Intended Audience 

This guide is for Medical Records Department Personnel who use Microsoft Amalga HIS to support Medical Records replenishment 

activities. 

Readers should be familiar with the use and operation of Windows-type operating systems, including the use of keyboard, mouse, menus, 

and other simple data entry conventions. 

This Guide does not cover Medical Records setup procedures. Please see the Medical Records Setup & Maintenance Guide. 

Disclaimer 

This guide is not a substitute for professional training in care giving procedures. 

This guide assumes professional training and certification of users performing medical records tasks to the requisite level set by local 

regulating authorities. 
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Introduction 
Microsoft Amalga Hospital Information System (HIS) is a dynamic information system, which provides integrated solutions, improves 

operational efficiency, and manages all hospital functions. 

This guide explains the key procedures central to the usage of the Amalga HIS Medical Record application.  Its intent is to equip Medical 

Records Department with the knowledge to efficiently and confidently use the application in the following capacities to name a few: 

 Request for medical records 

 Request from the appointment case 

 View the request 

 Checkout the record 

 Distribute the medical record folder to the requester 

 Check in the record 

 Support functions, such as creating a new record to the patient / edit / view, etc. 

 View history of the record 

 Archive and destroy the record 

 Medical coding 

Document Organization 
This document contains functional sections that correspond to typical daily workflow tasks of users involved in Medical Record activities. 

Each section starts with an overview of the purpose and application path for the process.  Diagrams illustrate the procedural steps required 

within the HIS application.  Screen shots of the key menus, dialog boxes, and reports, along with systematic instructions; show you exactly 

what you need to do to complete a work task. 

Additionally, tables list and describe the features of the fields within the Amalga HIS application.  Where possible, the reasons 

why computer procedures are organized in a specific way are discussed so that you can understand the 

advantages or constraints that have influenced the design of Amalga HIS. 

Occasionally, Hints & Tips can show you ways to take advantage of the innovations within Amalga HIS that enable you to save time, be 

more productive, and generally spend your day being more efficient and satisfied in your workplace. 

Conventions 
When reading the documentation, note formatting cues, as described in the following table. 

 

Document Conventions Description 

Notification of caution  Cautionary text advises that failure to take or avoid a 

specified action could result in loss of data. 

Notification of warning  A warning advises that failure to take or avoid a specific 

action could result in physical harm to the user or the 

hardware. 
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Levels to access a dialog box  Following are two examples: 

 Select File > New means select New from the File menu. 

 Select Options > Settings > Editor > Auto Completion indicates select 

Settings from the Options menu.  In the Settings dialog box, expand the 

Editor node and select Auto Completion. 

Code sample or screen report 

text 

Text set in – 9 pt Courier New: monospaced. 

Book titles and emphasized text Text set in - italics. 

Common Interface Elements 
The following tables list standard buttons, keys, and combination keys used in the HIS application. 

  Alternatively, you can click Alt and the underlined first letter of the Function to initiate the function. 

 

Function Buttons  (Alt + _) 

Enables you to search for values based on the selection criteria of the active screen. 

Clears the active screen in preparation for entry of new data. 

Enables you to add additional rows of details to dialog boxes or grids. 

Enables you to delete or remove a manually entered row. 

Saves new and/or modified screen data. 

Clears the active screen of user-defined data. 

Closes the active screen.  (This action does not save newly entered data.) 

Enables you to attach or review an Image document such as scanned images.  The (_) 

contains the number of attached documents. 

Enables you to access a drop-down list.  

 

Choice Buttons  Description 

Circular/Option 

button  

Option buttons enable you to select and activate one of multiple choices.  
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Choice Buttons  Description 

Check box/  

Boolean option 

Check boxes serve as Yes/No activation options, which can be stand-alone 

or grouped with other options. 

Field Search/ 

Ellipsis  

Ellipsis buttons open new dialog boxes, which enable you to search for 

relevant values for a specific field. (Also expressed as … in this guide.) 

 

Drop-down list 

this guide.) By default, each drop-down list is alphabetical. 

        This sequence can be adjusted by the user. 

  By default, each drop-down list is alphabetical.  This sequence is user-adjustable. 

 

 

Function Keys Description 

F2 Press F2 to change the field to Edit mode. 

F4 Press F4 to activate the search function. 

Enter Press ENTER to complete and validate your data entry. 

Tab Press Tab to move the cursor sequentially through all fields on a page or panel.  

This key can prompt most validation routines. 

 

Key Combination Description 

Ctrl+Shift Press Ctrl+Shift to balance columns. 

Ctrl+Alt Press Ctrl+Alt to insert table spacing before and after a table. 

Ctrl Press and hold the Ctrl key and click items to make multiple selections in a list. 

Shift Press and hold the Shift key and click successive items to make multiple 

selections in a list. 
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Common Interface Icons in Medical Records 

Icon List Description 

 

Caregiver to the patients 

 

Inpatient visit to the Hospital 

 

Outpatient visit to the Hospital 

 

Primary patient record 

 

Related patient record 

 

VIP patient visit to the Hospital 

Common Medical Record Fields 
The following table is a list of common medical record fields used in the applications.  This table serves as a reference for process 

descriptions discussed throughout this user guide. 

 

Term Description 

Archive Record Patient medical records marked as ‘Archived’ 

Appointment Patient request through appointments for the hospital visit 

 Barcode Scanner Barcode to identify the patient 

Check in Record Checking in the patient medical record back to the system 

Check out Record Checking out the patient medical record from Medical Records to the requester 

Code Browser Provide the search mechanism for favourite Doctor or Specialty by browsing 

through the Coding Standards 

Coding Report Medical Record Interactive Report and Amalga HIS retains the diagnosis and 

procedure in the same screen as in the existing Discharge Coding Interactive 

Report 

Coding System Medical coding standards helps for coders to code medical code effectively 
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Term Description 

Destroy Record Patient medical records marked as ‘Destroyed’ 

Diagnosis Type Patient diagnosis type 

Electronic Medical 

Record 

Provides patient medical records electronically to enable Doctors, Caregivers, 

and Medical Records Department to view medical records and perform tasks, as 

appropriate 

Expected Return 

Time 

Allows two options, the expected return date within 24 hours or when patient’s 

visit is closed 

ER Emergency Room 

HN Hospital Number 

IPD Inpatient visit to the hospital 

Linked Record The primary record is automatically retrieved for the linked records 

Location Patient’s location in this hospital 

Locked Records Patient medical records that are locked for selections 

Medical Coding Amalga HIS supports multiple medical coding standards for coders, such as 

CPT, ICD-9-CM, ICD-10, ICD-O-3, LOINC, and SNOMED. These standards are 

configurable. 

Medical Record 

Interactive 

Report (MRIR) 

Amalga HIS provides a user-friendly and flexible Medical Record Interactive 

Report (MRIR) and retains the diagnosis and procedures in the same screens as 

in the existing reporting. This report helps to query data for further reporting. 

Medical Record 

Tracking 

Amalga HIS patient medical record tracking (chart tracking) feature 

OPD Outpatient visit to the hospital 

Overdue Days Number of overdue days for patient medical record 

Paper Medical 

Record 

Supports paper workflow for patient medical records to keep track of patient 

medical records folder. Hospitals those are not ready for Electronic Medical 

Record can use the Medical Records Module to manage patient medical record 

folder 

Record Type Medical record types, such as Medical Folder, IPD, OPD, X-Ray to specify a 

patient. The record types are configurable. 

Resource The primary physician who attends the specific patient. 

 



 User Guide 

12 

Microsoft Proprietary and Confidential 

Standard Functions and Terms 

This section describes the standard and frequently used application functions available in the Amalga HIS Medical Record application. 

Grid Control Options 
Amalga HIS applications present data in a Table or Grid format.  These grids often require you to change or update information directly on 

the grid table. 

Column Heading 

In most screens that display search results, you can sort grid detail by clicking on a column heading. Sorting occurs automatically based on 

the column and column data-type selected. You can sort data alphabetically or numerically in ascending or descending order. 

 

Grid Rows 

To enter data directly into a grid row, right-click on the specific grid cell and select from the available options.  These options may include: 

Elliptical … search functions. 

 

This option displays a new search window, such as the Item Search dialog box. 

Drop-down lists. This option provides you with a limited number of predefined choices. 



Medical Records 

13 

Microsoft Proprietary and Confidential 

 

Enter text directly on the line and press Enter. 

Grid Output Options 
You can save, email or print the contents of grid rows. To access grid output options, right-click on the grid and select from the available 

options. 

  To access grid output options, right-click on the grid and select from the available options. 

 

Calendar 
You can set dates using the calendar feature. Access the calendar using one of the following ways. 

This feature is accessible in various ways: 

 Spin box:  Click on the day, date or year and scroll through the system options using the up and down arrow keys on your 

keyboard. 

     and/ or               

 Monthly browser:  Click the drop-  
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  Use the directional < > arrows to change the month as needed. 

 

 Item row selector: Click item row search … function to access the date picker and select the required date. 

 

Language Fields 
You can enter data in multiple languages by way of drop-down options. 

 

List Boxes 
 You can also select a list box on the left to load the corresponding page on the right. 
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List Box Options Panel 
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Prerequisites 
Amalga HIS is a dynamic and integrated Hospital system and all the applications and related reference tables are dependent on each other. 

Knowledge of these dependencies is essential for successful implementation. The following is a list of the system pre-requisites that are 

essential to successfully implement. 

Prerequisites for Medical Record Tracking: 

 Location setup system parameters 

 Printer setup 

 Form design for MR label and Request label 

 Employee and Resource setup (HR Module) 

 User and Group Security setup 

 Appointment scheduling for MR Appointments 

 Patient (HN and Demography) – Registration Module 

Prerequisites for Medical Coding: 

 3rd Party coding software, such as SNOMED, ICD10 etc 

 User and Group Security setup 

 Patient (HN and Demography) – Registration Module   
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Starting Amalga HIS 
You can access Amalga Hospital Information System (HIS) to access the assigned modules, depending on your access rights. If you have 

access to multiple modules, you have a wider range of security rights. The system provides a menu of applicable modules. 

To start Amalga HIS: 

1. Click the Amalga HIS desktop icon to logon. The Amalga Hospital Information System logon window is displayed. 

 

2. Enter user name and password and click . The Module menu is displayed. 

3. Select Medical Records from the available list and click the link to access the Medical Records Module menu. 
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Medical Records Overview 
In Amalga HIS, the Medical Records Module supports key functionalities, such as Patient Medical Record Tracking and Medical Coding.  

This module adheres to the following workflow highlighted and helps to perform the support functions, such as creating a new record for 

the patient, editing a record, viewing a record, etc. The following are the key functionalities associated with the Medical Records Workflow. 

 

Medical Records Workflow: 

 Request for medical records for ad-hoc or walk-in cases, or 

 Request from appointment cases where Medical Records Department views the list of appointments and makes request for 

medical records folder and Doctor Screen before patient’s visit to the Hospital. 

 View list of requests 

 Checkout record in order to send that paper medical record to the requesting area and to the requester. 

 Distribute medical record folder to the requester 

 Check in the record to make sure the medical record is back in to the system 

Other Medical Record Functions: 

 Support functions, such as creating a new record for a patient / edit / view, etc. 

 View history of record 

 Archive and destroy record 

 Medical coding 

In Amalga HIS, the Main Menu structure for Medical Records Module is as follows: 
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Amalga HIS consists of the following two modules to manage patient medical record. 

 Electronic Medical Record - provides patient medical records electronically to enable Doctors, Caregivers, and Medical 

Records Department to view medical records and perform tasks, as appropriate. 

 Paper Medical Record – supports paper workflow for patient medical records to keep track of the patient medical records 

folder. Hospitals those are not ready for Electronic Medical Record can use this module to manage the flow of paper patient 

medical record folder. 

The following are the support functions for medical record tracking. 

o Create Records 

o Edit Record 

o View Record 

o Linked Records 

o Record missing / found 

o View history of medical record and print label 

o Archive Record 

o Destroy Record 

All the above functions are explained in the appropriate headings in this guide. 



 User Guide 

22 

Microsoft Proprietary and Confidential 

New Medical Record Features in 
5.4 Release 

The following are the new features associated with the current release. 

 Expected Return Date Time - Allows two options, the expected return date within 24 hours after an OPD visit or when 

patient’s visit is closed (for Inpatients). 

 Receive Patient Medical Record - Allows tracking medical record folders in different location in the Hospital, the receiving 

location acknowledges when the medical records are received. 

 Linked Record – The primary record is automatically retrieved when a linked record is requested. 

 Bulk Archive Records – Allows archiving multiple records at the same time. 

 Destroy Records – New status for medical records to mark the records as destroyed. 

 QA Coding – Replaces the discharge coding screen and allows for coding both inpatients and outpatients. 

 Medical Coding Standard – Supports more coding standards in the system, such as CPT, ICD-9, ICD-10, ICD-O-3, LOINC, 

and SNOMED. 

 Code Abbreviation Maintenance – Allows setting code abbreviation for each individual and specialty. 

 Code Favorite Maintenance – Allows setting code favorite for each individual and specialty. 

 Medical Record Interactive Report – Replaces the Discharge Coding Interactive Report and retains the diagnosis and 

procedure in the same screen. 



Medical Records 

23 

Microsoft Proprietary and Confidential 

Creating Medical Records 
This section provides information on how to create a new patient medical record folder and print out the labels for the folders. Normally a 

medical record folder for a patient is created during a new installation for a new Hospital or attached to a patient medical record folder. You 

can create a new medical record if a patient currently does not have any existing paper record. Amalga HIS provides three options to search 

for a patient: sequentially, last digits, and HN (Hospital Number). 

 

To create a new medical record: 

1. Click Create Records in the Medical Records screen. The Create Patient Records dialog box is displayed. 

2. Select a medical record type. Amalga allows selecting medical record folders, such as Medical Folder, OPD, IPD, X-Ray from the 

drop-down list. The record type is configurable during installation. 
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3. Select a patient. For example, sequentially specify an HN from start and end HN as 100000010 (Start HN) to 100000020 (End HN). 

4. Click Refresh. This lists the following details: 

 HN 

 Patient 

 Record Type 

 Record Existence 

5. Click Select All. This selects all the records displayed on the screen. Also Amalga allows selecting record one by one and creating a 

new medical record folder for the patient. 

 

  The Show existing records option helps to display the HN for Medical Records that already exists. 

6. Click Create. This creates a new medical record folder for each patient selected. 

  A pre-defined Medical Folder Label prints out on a pre-defined label printer. 

By Record Type: 
This option refers to medical record type in Amalga HIS. The record types are configurable. The following are some of the record types you 

can select with: 
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 Medical Folder 

 IPD 

 OPD 

 X-Ray 

By Last Digit: 
This option refers to providing the last two digits of the HN to specify a patient. In the following example, all HN ending with last digit ‘40’ 

are displayed. 
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By HN Number: 

 

This option refers to providing a specific HN to retrieve the details for a specific patient. For example, you can specify ‘100000100’ as HN 

and get the details specific to that HN. 
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1. Select any of the following option in the Mode drop-down list. For example, Amalga supports Smart Search option and allows 

entering some of the first name or last name characters. For example, the first 4 characters of the first or last name. 

 Smart Search 

 Full Name 

 First Name 

 Last Name 

 Middle Name 

 Patient ID 

 Medicare Number 

 Passport 

 Tax ID 

 Social Security 

 Drivers License 

 Visa 

 National ID 

2. Click Search. This lists the patients, as per the search criteria. 

3. Select a patient in the list whose patient medical record is requested. 

 Click OK. The Request Patient Record dialog box is displayed. 

4. Scan the barcode for the corresponding medical record folder in the Barcode field. Alternatively, enter the barcode number if it is 

known. 

5. Select a record type that to request. The following list contains few of the record types and these records types are configurable during 

installation. 

 X-Ray 

 IPD 

 OPD 

  In order to request for a medical record, either bring up HN and select the record type or scan the barcode for the medical record 

folder using barcode scanner. 

6. Select a Doctor who requests the patient medical record. 

7. Select a location to send the medical record in the Select Area dialog box. Amalga helps to modify the requesting location. If the 

requesting location is out of the Hospital, an approval is required from the Hospital. Upon getting the approval, the Medical Records 

Department manually marks the location and attach to the medical records folder. 

8. Select a medical record type. Alternatively, use   option to select a record type. 

9. Set the expected return date and time. Amalga provides an option to set an expected return time within 24 hours after a request or the 

patient visit is closed. Normally for OPD cases, the expected return time is within 24 hours after the request. For IPD cases, it is 24 

hours after discharge or current visit. Amalga automatically populates this field for the current visit. 

 

10. Enter comments, if any. 

11. Click View Record. The View Record dialog box is displayed and helps to view the current status of the medical record folder and 

details, such as barcode associated with the folder, status (for example, ‘in store’), etc. 

12. Click Request. The request is sent electronically to the Medical Records Department for further processing. 
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  A pre-defined label with the request information prints out on a pre-defined label printer in the Medical Records Department. 

13. Click Close. 

To get the status of the request: 

1. Navigate to the Clinic Module and click My Requests. The My Requests dialog box is displayed. 

 

2. Specify request date in order to get the status of the previous requests. 

  The user can view all the requests if the Request date option is unchecked. 

3. Click Refresh. This lists the following details: 

 Requested – This refers to the requests made by the user. 

 Processed – This refers to already processed requests. 

 Declined – This refers to the declined requests. 

 Cancelled – This refers to the cancelled requests. 

Viewing Patient Medical Record 
Requests 

Once the request is sent, the Medical Records Department views the list of current requests that have not been completed by medical 

records. Medical Records can check out the records from here and send the folder to the requester. Amalga automatically lists all the current 

requests in the Hospital. 

To view a patient record request: 

1. Click View Request in the Medical Records screen. The View Request dialog box is displayed. 

2. Filter out patient record and view the request. Alternatively, use   option to select a specific patient record. The system 

automatically populates the record type for the selected patient record. 
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3. Scan barcode attached to the patient medical record folder. 

4. Select request date. 

5. Select requesting location. Alternatively use  option to select the specific requesting location. 

6. Click Refresh. A list of the searched requests is displayed. 

7. Select requests to be checked out. 

8. Click Check Out. Amalga pops up with a message box and confirms the check out. Once the patient medical record folder is updated, 

the checkout details can be viewed. 

9. Click View Record to view the patient medical record. Click Check Out to checkout a specific record to the requester. 

  At times there are chances the Medical Records Department receives multiple requests and identifies only one request as a valid 

request. In that case, the Medical Records Department can decline the request and update the status of the request as ‘Declined’. 

Normally this is due to Nurse or Clinical Staff clicks request multiple times and then those requests gets duplicated in the 

system. 
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  The Advanced option allows checking out the records individually. Amalga displays the Check Out Patient Record dialog 

box and this brings up the full check out patient record details and current status of the patient medical record. 
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Amalga provides the Advanced check out option with a specific Doctor, location, comments and in addition, provides the ability to modify 

the properties and attributes for the fields, such as the return time, etc. 
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10. Modify details, such as ‘check out to’ new location, and expected return date. 

11. Click OK. This check out the record and mark the record as ‘checked out’ and status as ‘Out of Store’. As a result, the medical record 

is dispatched to the requesting location. 

12. Click View Record to view the patient medical record. 
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By Medical Record Type: 
This refers to medical record type for the patient medical record request. Amalga provides this option to filter the request search based on 

the record type. 

By Date: 
This refers to the requested date for a medical record. Amalga provides the Calendar option next to the Request date filed to specify the date 

for request. 

By Requesting Location: 

This opton refers to the location that requested the medical record. 
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If the requesting location is out of the Hospital, an approval is required from the Hospital. Upon getting the approval, the Medical Records 

Department manually marks the location and attach to the medical records folder. 
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Checking Out Medical Record 
Amalga helps you to check out medical records from the Medical Records Department in different ways. Based on the needs, use any of the 

following options: 

 Once you have viewed the patient medical record requests, you can perform a quick check out 

 You can perform Advanced check out by checking out the records one by one 

 Checking out multiple patient medical records (batch check out) 

As Medical Record Staff, if you already have the medical record folder on your desk, you can use the barcode in order to search the medical 

record information in Amalga. Normally the Medical Record Staff follows this approach to look up the record individually. If you have an 

existing request for the same medical record folder, the system pops up a message and prompts for your confirmation. You have the ability 

to select which record(s) to be checked out. 

 

To check out multiple medical records (Batch Check Out): 

1. Click Check Out Records in the Medical Records screen. The Check Out Patient Records dialog box is displayed. 

2. Select patient medical record to be checked out. The drop-down option in the patient box helps to select a previously visited patient 

record. The medical record can also be identified by means of scanning the barcode on the medical record folder. 
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  If there are existing requests for this medical record folder, another screen pops up and prompts for confirmation. Amalga 

provides the ability to select whether to complete this request. 

 

3. Select medical record type. Alternatively, scan the barcode to identify a patient. 

4. Click Add once the record is identified. The records get listed to be checked out. 

  The Remove option helps to remove a patient’s folder from the list. 

5. Select the medical record(s) intended to be checked out. The bottom of the screen displays the details, such as the selected record to be 

checked out to the specific Doctor, location, and expected return time. 

6. Click Check Out. This check out the selected records as batch. 
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